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1. KSL Email Designer

KSL Email Designer is provided as a standalone product to manage email communications. KSL Email
Designer is also provided as an optional module of KSL Suite and KSL for Salesforce. 

Please refer to the KSL for Salesforce documentation for implementing emails and emailings with
Salesforce.

1.1. Email, communication & KSL

Email is an alternative and complement of mail channel which allows to cover several types of
communications, sent by the different departments of a company to target customers and prospects.

For marketing & communication departments, the mass-emailing (also called emailing) allows to deliver:
newsletters, information letters sent periodically,
invitations to an event,
marketing messages and targeted outbound communication

This communication is generally a part of a marketing strategy to sell, to prospect or simply to retain
customers. 

These emails can also be involved in a multichannel scenario driven by customer data: in this context,
business data is sent to KSL to create the communications corresponding to the appropriate channel and to
send them.

For a customer management department, email allows to rapidly exchange with customers. In this context,
communication are either single transactional email to a single recipient or emailings to a list of recipients.
In this case, email allows to deliver:

order and payment confirmation, account activation, response to a client,
information sent to a client to inform him that his invoice, his statement or his contract is available in
his web account, 
automatic payment reminders,
Etc.

Email is also a fast and efficient internal communication medium, usable to communicate with all
employees and departments in a company.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 4 55
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More than half of the emails are now read on adaptive and
mobile media.

It is therefore essential to optimize emails, for a readable and
pleasant content on screens of any sizes... or lose half of the
readers.

KSL Email Designer is positioned as a centralized collaborative platform. It provides a tool to delegate and
share the email and campaign management to the different department of a company.

KSL Email Designer offers companies the ability to implement a collaborative and controlled organization for
email communications:

Centralized content management: creation of paragraphs and images used by emails
Centralized template management: e.g. marketing and document production teams can create and
share email templates
Delegation of the creation of personalized emails: departments, commercial teams and assistance
teams can autonomously create, test and launch emails and emailings, in using emails validated by the
marketing department
Centralized email delivery for a global, automated and recurrent communication

Ksl is positioned to create responsive emails on these multiple uses, taking advantage of a transverse
environment, as much for its shareable resources as for its industrialized production and delivery
processes. 

1.2.  KSL Email Designer, an All-In-One tool

This guide describes the use of KSL Office application in the context of KSL Email Designer.

KSL Email Designer is the KSL email management function and
product and is based on:

a repository sharing all the resources: style sheets,
images, graphical blocks, personalizable templates and
hyperlinks,
the KSL Office application, a portal to manage the
repository,
the KSL Interactive application for creating email
templates and for personalizing email before delivery.

These three elements allow a quick and intuitive implementation of KSL Email Designer and provide a

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 5 55
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solution for communication and marketing professionals, but also for business teams and business experts.

1.3. In 3 steps, 3 actions: assemble, personalize, deliver!

All can be done in 3 steps:
Assemble predefined graphics blocks or use a custom template of the library.
Enrich, personalize and add variables to email in respecting the graphic rules of the company.
Visualize and transmit the preview for validation, then deliver the email or emailing campaign.

Get started, we accompany you on every step!

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 6 55
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Terms of use of this guide

The rights to use the software described herein are assigned under a license agreement and this guide may
only be used or copied in accordance with the terms of the contract.

The information in this guide is subject to change without notice.

The reproduction or transmission of the information in this guide is limited to internal use by the customer
and for the sole purpose of proper use of the software. Any other reproduction or transmission is prohibited
without the express written permission of NAELAN.

This guide is provided by NAELAN for information on the software delivered. It does not in any way constitute
a contractual commitment both on the features indicated and in their implementation.

Unless otherwise stated, the companies, names and data used in our examples are fictitious ; any
reconciliation with real companies or entities would be the result of coincidence.

Typographic conventions

Text file sample Code example or file settings

Note, information

 Chapter, Guide Reference to another guide or chapter

Example Example, variable, code extract

Keyword, label Keyword, application label, important item

Contact Naelan

Headquarter - 4 rue Claude Chappe
69370 Saint-Didier au Mont d'Or France
+33 4 37 59 81 40

www.naelan.com
support@naelan.com

Office in Paris - 4 Place Louis Armand 
75023 Paris France
+33 1 72 76 80 67

contact@naelan.com

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 7 55
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2. The guide of responsive email

The "responsive" behavior is the techniques used in order for an email (or a website) to adapt its form to be
read on any device, from the XL screen of the desktop to that XS screen of a smartphone. 

It preserves the visual and understanding of the message by rearranging the design of the initial
communication via programmed automatisms: image zoom, serialized or parallelized information blocks,
among others.

2.1. Responsive email is not a printable document

Responsive email and mail are two forms of communication that differ on their form and objectives.
Therefore, it is often difficult to share complex KSL components like groups of text zones and text zones
including tables.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 8 55
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However, some components can be shared by mails and emails
Style sheets
Pictures and photos
Simple text zones, without tables, associated with a style sheet component

2.2. Basic rules

The basic rules to create a communication by email are:
Create an interesting or appealing visual, whose organization is adapted to the smallest screens =
"mobile first"
Create real interactivity, easy-to-operate links and buttons regardless of the reading device
Use character fonts and images adapted to the "responsive" mode
Create a synthetic and quickly read content to facilitate reading

2.3. Recommendations for responding to device constraints

The tips below will allow email to be open and read in the best conditions on a large number of browsers
and devices.

A responsive email template has an optimal width that is between 500 and 650 pixels, to avoid a
reader to use the horizontal scrollbar (in addition to the vertical scrollbar!) on his mobile.
Use standard fonts: Times and Georgia for fonts to serifs, Arial, Helvetica, Sans-Serif, Trebuchet,
Tahoma, Verdana, Impact (and some other variations) for proportional fonts without serifs, mail for
non-proportional fonts (to monospaced fixed font).
Prefer a font size of 14px for the body of mail, for an optimal readability.
Concerning a columned presentation of content, an information block on 2 columns is ideal. It is also
common to find a layout on 3 columns, with a maximum 4 columns.
Anticipate the reading order for the information blocks, which will be presented in Z on the smallest
media (see illustration above).
Avoid superposing an important message on an image or a background frame (white message on a
dark background for example) or including it in the image. Some email clients systematically block
images (background and other), and propose to the user to download them... or not.

2.4. A direct impact on the resource creation, available in KSL

A simplified style sheet, adapted and dedicated to email. This component is built from corporate
design rules, but it is often necessary to change the character fonts and their size.
Some text zones scaled for emails, with a layout of 600 pixels (format B5 for example), without any
margin.
Tables systematically with 1 to 4 columns, for every graphical blocks and personalized templates.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 9 55
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3. Ksl Email Designer

KSL Email Designer comes with a KSL project sample that contains the key elements to implement the solution
in a company. This project is designed to be customized to meet all the needs.

3.1. The content of the project

KSL Email Designer is a function which requires a license. The project and its specific services are provided to
customer which wants to install it for test or with its KSL Email Designer license.

The KSL Email Designer package is an independent project "EMAILING" which can be modified:
A complete project environment: 
- A classification tree for components and services

- Basic rights: two groups, EMAIL_ADMIN and EMAIL_USER, and different rights on components and services

- Two profiles: Emailing_Admin and Emailing_User, to target the different KSL Office views

Some directly usable components:
- a style sheet "FS_EMAILING" dedicated to email 

- a ksl font component (for character fonts)

- a library of graphical blocks ready to be assembled for creating templates

- a library of personalized blocks as an example

- some plug'n play personalized templates for example

A service for creating and personalizing emails: "MaquetteEmailing_500px"
A service for creating and previewing email bodies: "BuildResponsiveEmail"
A set of actions (and associated services) available for the design of emailing
A validation workflow with its actions et associated services
A set of actions (and services) available on the archived emailing campaign

3.2. A project integrated to an existing project or an independent project?

It is possible to use emailing in an independent project of the KSL repository, with its own resources; the
project will have its dedicated options; in this case, the default EMAILING project provided can be used as a
plug'n play project:

Import the EMAILING project
Create two users (admin and user) and insert them in the default groups
The default actions will be available without any settings

If it is necessary to integrate the KSL Email Designer function to an existing project: 
Select the Import/Export then Import menu
Select the EMAILING project by selecting ? for the Import file or directory name field then click the
Next button
Choose a Full import and specify the following parameter fields:
- Project name: select the project where integrating the EMAILING project

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 10 55
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- Verify that Suppress objects that are not in imported project is not selected.

- Check the Import permissions and add to existing permissions option for groups is checked

- Verify that the Import Office profiles is not checked

Adapt manually the storage map branches of the EMAILING project to the classification of the project
and the Office profile of the project

 Important notes: 
If some rules exist for text zones in the target project, do not import rules; adapt if necessary manually
the rules and rights.
If some Office profiles already exist that need integrating emailing function, only add the emailing
dedicated view to the profiles thanks to the Ksl Office Setup > Office profiles menu of KSL Admin.

In the two cases, a minimum step of configuration will be necessary to adapt the standard emailing project
to the context.

3.3. Setting the environment

KSL Style sheet and Fonts

The default style sheet is shared by a set of resources of the emailing project. It is possible to modify them in
order to respect the different corporate styles rules via Ksl Studio or KSL Office.

Several style sheets can be managed in a KSL Email Designer project, which is very useful in the
multi-brands/languages contexts.

It is also possible to add the styles and patterns of the emailing project to an existing style sheet component;
but in this case, change in Ksl Office the style sheet of all the graphical modules and the style sheet used by
the edition/template "MaquetteEmailing_500px" in Ksl Studio.

 Attention:
If a style sheet is linked to the email components, be careful that the styles are interpreted by most of
the browser -  chapter 2.
the character fonts used by the style sheet, and potentially usable by responsive emails, must be
present and have a mapping in Ksl Font (KSL Font is managed in KSL Studio only).

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 11 55
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Several style sheets can be managed in the project, but it is recommended to have the same style
sheets for all the components used by an email or an emailing: indeed, if a style sheet is defined when
creating an email, and if the styles used in each component have no consistency with the style sheet,
the production of the email will be stopped and in error.

The "project" settings

The Emailing project can be configured in Ksl Admin by selecting the Emailing project in the menu Projects >
Project List.

When setting up the project as an autonomous project, the default settings for the new components are:

This formatting is fully adapted to the creation of new components dedicated to responsive email.

The classification tree

The classification of components and services of the project can be defined in the menu Storage maps >
Components of Ksl Admin.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 12 55
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These classification trees are dedicated to components and services.
Archived documents share a different classification tree.

The branch "BIBLIOTHEQUE DESIGN EMAIL" (in English email library)
contains all the resources needed for a fast design of an email:
graphic or custom blocks, custom templates (groups and text zones).

The branch "CHARTE GRAPHIQUE" (in English Style Rules) contains
the style sheets.

The branch "FICHIERS ANNEXES" (in English Annexes Files) contains
the file defining the shared hyperlinks and data dictionary for
Salesforce.

The branch "IMAGES & ILLUSTRATION" contains the graphic images
and illustrations used in the blocks and models of the project.

The last last branches contain the different production services.

The user groups

In the menu Permissions > Groups in Ksl Admin:
The group EMAIL_USER (or users) corresponds to document/email designers. These users create their
emailing, test it and send thme in a validation workflow, before sending the campaign to customers.
The group EMAIL_VALIDATOR (or validators) corresponds to the users who validate the user's
emailing; they also have the ability to modify the content directly.
The group EMAIL_ADMIN (or administrators) corresponds to resource managers. They control the
end-to-end emailing process (preview, test, campaign launch and archiving) from the design interface.
In addition, they have control over the management of all production resources: access to image
libraries, email templates, email blocks, test files, etc.

 Notes concerning user groups:
Include users to these groups for an implicit implementation of the permissions described in this
chapter.
These groups can correspond to the groups or roles of the user directory. Refer to the KSL Server
Integration Guide for more details.

Permissions given to components and services

In the menu Permissions > Components and Permissions > Services in KSL Admin, and for each group
created, it is possible to modify the "components" rules, especially in the context where emailing is
integrated to an existing project.

The AccesBibliotheques rules (LibraryAccess in English) manages the permissions to add, delete, modify
and personalize the different content: templates, personalized and graphical modules.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 13 55
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The AccesData rule manages access permission to files available in the repository, mainly the file
defining hyperlinks and the file including test recipients.
The AccesImages rule manages access permission to the shared pictures of the repository.

With regard to permissions on services, the three groups have the right to create an email using the services
of the directory (/SERVICES EMAILING). The ADMIN group has permissions to add and delete components of
this directory.

Mail account for sending emails

A "MARKETING" mail account is defined by default in the menu Distribution > Email accounts in KSL Admin.
It is necessary to configure it for delivering emails.

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 14 55
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The "MaquetteEmailing_500px" (default KSL email template) can be configured with the menu Services >
Services and its parameters can be modified in Ksl Admin

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 15 55
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MailCsvFile Recipient list used for sending emailing (production data file)

This file has the following characteristics:
Predefined fix structure
csv or txt file format
one recipient per line
with or without an header line
each column value separated by ";"

This file can be downloaded (action "Browse " locally), to be specified in the
parameter configuration. In this case, no default value are set.

Example:
Mr;Corentin;POUJON;corentin.poujon@naelan.com
Mrs;Estelle;CHASSIS;estellechassis@orange.fr

MailCsvTestFile Recipient list for testing

The file defined with this parameter has strictly the same characteristics as the
MailCsvFile file. This parameter allows the user to specify a test file from a list of
predefined test files created in the repository or available on a local directory.

MailCharset Code page of external files (recipient list)

Set by default on universal UTF-8 code page. This parameter allows to set the
encoding codes used by the csv or txt files used. 

A list of code pages are provided:
Universal (UTF-8)
Windows (windows-1252)
Linux (ISO8859-15)

MailTitle Email object

Mandatory parameter for launching an emailing. However, it is not necessary to
assign a default value to it.

Mail Account Recipient identification

The default sender is typically selected from the list of mail accounts defined in
the Distribution menu (see above).

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 16 55
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feuillestyles Style sheet

By default, the standard KSL style sheet is selected.

If multiple "mirror" style sheets exist (same style name with different colors and
fonts), let the user choose it from a list of style sheets.

If no style sheet is associated with this parameter, the style sheets defined for
each components will be used.

MailCsvHeader Column list of the recipient files

This parameter is not displayed (by default) when launching the emailing; it
contains the descriptor of the contact file, i.e. the names of the fields separated
by the character  ";".

Example:
TITLE;FIRSTNAME;LASTNAME;EMAIL_ADDRESS

The field names must correspond strictly to the names of the
variables/fields inserted in the email.

A "#" added at the beginning of the header line of the recipient file allows
to describe the file, as an alternative of the MailCsvHeader parameter; but in
this case, the MailCsvHeader parameter must be empty.

Example:
#TITLE;FIRSTNAME;LASTNAME;EMAIL_ADDRESS
Mr;Corentin;POUJON;corentin.poujon@naelan.com
Mrs;Estelle;CHASSIS;estellechassis@orange.fr

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 17 55
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MailUrl Image location URL

This parameter is mandatory. It allows to define the image location address
(URL). All the images used by emails will have to be stored in this location. This
URL must be permanently available so that email image be displayed on any
media and device.

Example:
http://ksl.naelanserver.fr/officeemail/pictures

It may be interesting to synchronize the physical components/picture
directory of the project of the KSL Server with this dedicated URL, so that it
automatically benefits from the latest images added to the KSL repository.

The URL set in the default project (http://localhost:8080/pictures) addresses the
local image directory of the workstation. Just copy the contents of the/picture
directory of the emailing project to the /Tomcat/webapps/pictures
sub-directory. This setting facilitates testing by allowing to display the
responsive HTML5 rendered for email bodies during emailing design, but this
URL is not suitable for production: choose an shared and always available URL.

MailBat Preview indicator

This Boolean parameter is automatically set to true or false depending on the
production service used: preview or delivery.

Any other parameter value in this service will overload the one transmitted when creating the mail, or the
parameter value defined as a default in the "MaquetteEmailing_500px " service. 

The DiffusionEmail and DiffusionEmail_Test services (emailing based on a recipient list) are composite
services integrating the BuildResponsiveMail service. They also inherit values transmitted to the
"MaquetteEmailing_500px" service parameters; the value of these parameters must not be directly set.

Preview actions and Preview action groups associated with email creation

The menu Services > Preview actions allows to access to all the user's actions:

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 18 55
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When creating or selecting an action, it is possible to set its parameters and the action button icon:

A set of icons are provided, for example the icon for a display of email html bodies. But a customized
button can be configured for each action.

The menus Services > Preview action groups allows to define groups of actions:

3.4. A view and services dedicated to email

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 19 55
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The Emailing view of KSL Office

The button Emailing allows to create an Emailing tab in the KSL office portal. This tab is a view specific to
KSL Email Designer for creating and sending e-mails or preparing e-mail campaigns.

This view is accessible in the following conditions:
The project contains services.
The user, or the group to which he belongs, is allowed to access the production services dedicated to
the e-mail (select the option E-mail creation in the permission parameters relative to the tree node
where the email service is classified).
And the KSL Office portal profile includes the Emailing view.

This view of "production of e-mailings" differs from the Document production view by a set of special
features, including:

The ability to directly save the email created as a template in the resource repository.
The ability to add new variables to the dictionary. The user can then integrate them into his content
when designing an email. When he launches the preview or send the email, these variables will be
replaced by the data of the contact list (file .csv).
The ability to add hyperlinks on an image or text.

Unlike an interactive document, it is impossible to integrate external files or local images into the
interactive e-mail created in this view; these features are inappropriate for creating an e-mail body.

The button allows to manage the view settings. This view is very close to the view Document production.
It has a similar configuration for simplifying the editor toolbar.

Parameters of the Emailing view:

Parameters Description Default value
Page title Page title associated to the view. Emailing

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 20 55
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Project Project on which the view will be based. The default project of the
current profile or the project
on which profile was created

Allow saving text
zones in repository

Allows a user who has the appropriate permissions on the
repository, to substitute from the interactive editor, a text
zone of the repository by its modified version of his
interactive e-mailing. This saving changes text zones in the
repository.

No

Allow refreshing from
repository

Allows to refresh all unmodified text zones of the interactive
e-mailing. The text zones of the e-mailing are replaced by the
newer repository text zones.

This parameter allows a user from the interactive e-mailing
to update all non-personalizable fixed content of his archived
interactive e-mailing, whose content has been frozen. This
saving changes text zones of the interactive document.

No

The content of this document is the property of Naelan and cannot be used or reproduced without a written authorization. 21 55
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Allow refreshing
personalized text
zones

Allows updating text zone of an interactive e-mailing to
newer versions (of these text zones) available in the
repository.
This parameter applies only to archived interactive
e-mailing.

3 possible values:
Three values are possible:

Allowed: the user can refresh the text zones that have-
been personalized.

- Not Allowed.

Allowed only when document is frozen (e-mailing whose-
contents were frozen during archiving).

If this parameter is set to Allowed or Allowed only when

document is frozen, then the button  or  appears on
to the right of each text zone that has been personalized in

the interactive e-mailing. The button   appears when if
the date of modification of the text zone in the repository is
greater than the one in the e-mailing. This button replaces
the personalized text zone with the reference text zone of
the repository.

 After substitution, the button  of the tool bar allows
to cancel the action (but if you quit the interactive e-mailing
and reopen it, the previous action cannot be cancel
anymore).

 It is important to note that this update feature is usable
for any interactive e-mailing, archived or not (with
restrictions on its frozen or non-frozen nature for the 3rd
value).

Allowed only when document
is frozen

Allow saving email as
a model

Allows the user, on action Save email as template to create a
new group with a custom name in the repository. This new
group is a copy of the main group of e-mailing that has been
designed and is to be considered as the model of e-mailing.

Non

Root folder for
repository

Parent folder for inserting text zones or groups in the
repository : this is the branch of the classification map under
which all the resources necessary for creating the body of
e-mail are available: template library, graphic blocks and
custom blocks.
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Default style for
hyperlinks

Text Style used when inserting a new hyperlink and which is
present in the style sheet used by the e-mail. This style
makes it possible to distinguish the hyperlink within the text
of the e-mail.

This parameter is not mandatory, in which case the text on
which the link is added remains in the current style (but not
recommended).

In any case, it is possible to change the style of the text
associated with the link after creating contents.

Enable the bold menu Enable or disable menus and buttons to set text in bold. Yes

Enable the italic
menu

Enable or disable menus and buttons to set text in italic. Yes

Enable the underlined
menu

Enables the activation or deactivation of menus and buttons
to underline text.

Yes

Enable the
subscript-superscript
menu

Enables the activation or deactivation of menus and buttons
to set text in subscript or superscript.

Yes

Enable the text color
menu

Enables the activation or deactivation of menus and buttons
to color text.

Yes

Enable the
background color
menu

Allows the activation or deactivation of menus and buttons
to color background text.

Yes

Enable the change of
style

Allows the activation or deactivation of menus and buttons
to change the style of the text.

Yes

Enable the alignment
change

Enables the activation or deactivation of menus and buttons
to change the alignment of the text.

Yes

Enable the variable
insertion menu

Enables the activation or deactivation of menus and buttons
to insert a variable.

Yes

Enable the stylesheet
menu

Enable or disable menus and buttons to change the style
sheet.

Yes

Enable the local
image insertion menu

Enables the activation or deactivation of menus and buttons
to insert a local image.

Yes

Enable the repository
image insertion menu

Allows the activation or deactivation of menus and buttons
to insert an image of the KSL repository.

Yes

Enable the borders
and shading menu

Enables the activation or deactivation of menus and buttons
to manage borders and shading.

Yes

Enable the paragraph
menu

Enables the activation or deactivation of menus and buttons
to manage paragraphs.

Yes

Enable the bullets and
numbering menu

Enables the activation or deactivation of menus and buttons
to manage bullets and numbering.

Yes

Enable the variable
format menu

Enables the activation or deactivation of menus and buttons
to manage the format of variables.

Yes
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Enable the caesura
menu

Allows the activation or deactivation of menus and buttons
to manage the hyphenation.

Yes

Enable the table
menu

Enables the activation or deactivation of menus and buttons
to manage tables.

Yes

Enable the spell
checker menu

Enables the activation or deactivation of menus and buttons
for the spell checker.

Yes

Add Email creation permission on a repository subtree to a user or group of user

In the menu Permissions > Services in KSL Admin, permissions can be defined to allow users to created
email from the repository:

It is necessary to gather the services that produce the "responsive" emails in the same node within the
classification tree of the repository.

As for permissions given to an interactive document template, this tree will be "typed" as "E-mail creation";
which will allow services to be available in the dedicated view, and only in the dedicated view.

3.5. Office, a content management platform dedicated to functional administrators
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A functional administrator can have 4 views or tabs on this autonomous and shared design platform, as a
thin client:

the style sheet to implement the graphic charter common to all bricks
the library of shared metamodels and resources (images, illustrations and content) for maintenance
the email design platform
validation workflow and archived campaigns

An end user may have views restricted to email design and archiving.
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4. A library of shared and modifiable resources

4.1. Description of the default "FS_EMAILING" style sheet

The FS_EMAILING stylesheet can be modified thanks to the Office application with administrator's
permissions.

Based on the 3 colors, plus white and black, on color patterns:

These background colors allow to structure the different information blocks in emails.

An only one character font: Arial 
Size 11 for content,
Provided in several heights for titles and legal notices,
and in several colors for dark backgrounds
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A simple bullet point style (style arial) for listing text items in emails:

4 line styles: bold white, color, light and dark lines, mainly for the borders of information blocks:
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Changing style sheets: 'mirror' style sheets

When a new email is created, a parameter (stylesheets) allows to change the default style sheet. 

The reference style sheet can effectively be replaced by a new style sheet, provided that it contains strictly
the same identifiers for the objects used: name of styles, name of patterns, name of lines styles and name of
bullet points. 

These elements can, of course, be configured differently: 
Color change for the patterns, 
Font, color and style changes
Line color change, etc.

For ease, the new style sheet is created from the reference style sheet (File, Save under) and immediately
stored in the repository. The object configuration is then changed without affecting their designation.

These style sheets are called "mirrors." They allow to instantly adapt the graphic styles of a communication
during its production, without modifying its components.

4.2. Graphic modules or blocks

The components displayed below are accessible and can be modified via the repository of the Office
application. 
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Graphic blocks or modules are the
components for a consistent and perfect
email design.

They have a format and characteristics
that meet the requirements of responsive
email, especially in terms of size and
presentation to anticipate the formatting
of information on smartphone screens
(for example).

The repository contains a library of blocks of different structures: banner image, title and text, image and
text, image and text on 2 columns, on 3 columns, title and list, varied text, title alone, etc.

The objects of each block are arranged within a table that will allow a harmonious reorganization of the
information during the responsive adaptation. The width of this table fully fills the width of the block.

These blocks can be re-adapted to a corporate identity. The list of blocks can also be enriched to meet
specifications in terms of presentation of information, for more efficiency when creating an email. In this
context, it is simple to copy an existing block to complete or transform it.

4.3. Configuring blocks of information

Responsive mode automatically reorganizes the cells of an information block by passing them under the
other on a Z format, for a smaller display. 

In a table with multiple columns and lines, it is not recommended to split a single "y" column on several lines
or to merge several lines "in y" on a single column. The new cells will not be "rolled up" in the consistent
order of initial presentation of the information.

Below are some illustrated examples of possible cuttings:

1 2 3

1 2 3
4 5 6

1 2 3
4 5
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1 2
3 4 5

and some examples of cuttings not recommended:

1 2 3
4 5

1 2 4
3

4.4. Custom modules or blocks

Custom blocks contain meaningful texts and/or images and are potentially reusable, i.e. shared by multiple
emails. They are copied, for the form, from the library of graphic blocks.

A "company" banner (logo + illustration), a contact block, a signature block, company contact information,
legal mentions, icons of social networks... are all elements that can be assembled within several email
templates, or recalled directly when creating a new email.

The modification or update (addresses, phones, mentions, hyperlinks, logos...) of a custom block
automatically impacts all models of email that use it.

4.5. Model library
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Custom templates are an assembly (or group) of already customized blocks or graphic blocks to personalize
when designing the email. 

A model may be intentionally incomplete, and contain only the upper or lower part, and especially the
mandatory information. It will then be completed when creating the email with new blocks of information.

 Notes:
Any block customization in the custom model directly impacts the block customized and, therefore, all
the models that use it. It is therefore recommended to change carefully the model in the repository.
The library of custom models, "My Models", will be mainly enriched during the process of designing a
new email, since it will be possible to save it as a model.

SOME RULES TO AVOID MISTAKES

Custom models allow the administrator to impose basic rules to secure the email design.

Select the block, right click and select Properties.

Each block in a model:
Can be allowed or not to be modified in KSL Interactive (option set by default); if not, its content will be
locked.
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Can be allowed or not to be removed in KSL Interactive (option set by default); if not, the block is
locked.

It is therefore possible to make the content of certain blocks mandatory on the model for the user who
designs the email: top header, company logo, contact block, legal mentions..., to avoid unfortunate updates
or update problems.

4.6. Additional files

The centralized hyperlinks file "emailing_links.csv" is available in the repository tree.
Each link potentially shared by a group pf email (company website, social network access, opt-out link for
example) is defined by a line following the format below:

Identifier;label;URL

This list is to be completed. It is accessible when the user inserts hyperlinks in the email, on a text or image.

4.7. Images & illustrations

The STANDARD branch contains the illustrations shared by the graphic blocks.

The NAELAN branch contains examples of custom blocks. 
This branch will be replaced by the usual storage space for the project illustrations if responsive email is
integrated into an existing project.
It can also be completed to dedicate a branch to the illustrations of the responsive email.

Adjust the picture call to the recipient's profile

It is possible to modify the picture called during the composition of each email, by varying its name using
fields associated with the targeted recipient. It is then necessary that these fields are present in the stream
transmitted for the Emailing.

In the repository,
Position the cursor on the picture which must be conditioned
Right click, then select Properties
Replace all or part of the picture name by a variable available in the data flow; this will be entered
between rafters (< and >)
If it is necessary to completely replace the picture name, the variable must also contain the extension
associated with the picture
The name thus composed must correspond to the name of picture present under the configured URL
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Access to the picture name in the properties is conditioned by a parameter present for the Repository view
(configuration of Office profiles under Admin).

 Notes:
All images used or potentially usable in the mail body must be present and accessible by the URL (the
parameter MailUrl which is a mandatory information for the MaquetteEmailing-500px service), in
addition to their presence in the repository. 
As specified on the setting part, it may be interesting to synchronize the physical directory
components/picture of the project with this dedicated URL, so that it automatically benefits from the
latest images loaded into the repository.
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5. Create an emailing

5.1. Create and set up an emailing from KSL Interactive

To created an emailing, click on the Emailing tab, then choose an email creation service; The "Create an
Email" service is available by default.

 An email or emailing can also be created from an external application (e.g. a CRM software).

The parameters of the service can be selected:
The meta model used, chosen from the meta models available in the repository. The latter can be
summary and include only a set of basic bricks and non-modifiable legal notices for example. It can also
be defined by default and not be accessible at the level of this design form.
The recipient addresses for tests
The recipient addresses for launching the campaign

 Notes concerning the input data:
Several ways to link the contact list to the emailing campaign:

Upload a file, i.e. select it on the local workstation or on the shared directory of a server on which the data is-
usually available; In this context, it can be test files or the final production list of contacts for the campaign.

Choose the contact file via the combo-box from a list of predefined files. The files will be accessible in a-
directory of the server, but the list remains relatively limited.

Select a set of criteria/parameters (age, gender, zip code, etc.) that will drive data extraction before starting-
the email processing. This advanced integration action can complement the default integration (to be seen
with our KSL Suite consultants).

The code page of the file, depending on its source (e.g. universal UTF8, Windows 1252 or Linux
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iso8859-15)

The header elements of the email: 
Object (mandatory): Note that object can be personalized with variable using the data of the recipient list;-
Simply enter the exact name of the piece of data (or pieces) between angle brackets where inserting a data.
For example: <FIRSTNAME>, we wish you good holidays!

- Sender: it is the mail account declared in the Distribution menu in KSL Admin

The image storage URL is completed by default for all launches; this option is rarely visible on this form.

It is also possible to activate a dynamic selection of a style sheet, in the particular context of a
multi-brand management for example (see chapter 4.1 - mirror-style sheets).

These parameters can be changed at any time when designing the email.

These email services gives access to the design tool of the communication.

5.2. Choose how to start the new emailing

By default, at the beginning of the emailing creation process, a blanc page appears and the different
resources of the library are available:

Custom models 
Custom blocks
Graphic block to custom

It is possible to select one of the existing models and customized it, or select and assemble some
blocks/modules, in order to create a new emailing and, why not, a new model.
To do it, access to the library and drag and drop a model or blocks in the blank page.

Emailing creation from an existing model:
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Emailing creation by assembling blocks:

5.3. Personalize the content of the emailing

No matter how the emailing is built, the selected content can be personalized by double-clicking it.

An image presented can be substituted by an image available in the repository:
Double click on the image: a blue filter indicates that it is selected.
Right click than select Insert an image from the repository
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It is not possible to add local images because an email that arrives in the inbox of a recipient includes
the URL to the images and images are downloaded before displayed in the page. The images are never
"embedded" in the mail body to avoid sending oversized emails. The images will therefore be stored in the
resource repository but also on a shared web directory accessible at any time to recipients.

It is possible to fine-tune the size of images but in any case they will be adapted to the recipient's
device (responsive email), while remaining proportional. The width specified in the properties will be the
maximum width of the image.

Replace, review, personalize texts and titles

The selected style sheet will allow to always respecting the styles rules.

Add action buttons

Adding buttons is mandatory for an interactive communication: these buttons will consist in images with an
hyperlink.

Work with background colors on each cell of information

Each block can potentially be colored using the patterns defined in the style sheet.
In the menu bar, select Format > Borders and shading, and then the pattern in the predefined list.
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An information block can be highlighted with a dark background; in this case, simply use a clear or white
font color for text.

A background color can be associated to the different cells of a block. Select the cells, then select the
option Tables > Cells properties, and choose a pattern of the style sheet. Note that the color of the cells will
cover the background of the block.

     

Complete an existing block (with an extra line)

To complete a block, add lines as  for a table with the menu  Tables > Insert > Line before or Line after.

Don't forget that a Z structure has to be created for the cells in order to get a responsive display of
information.

Add a new block/module in a model
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Select the graphic or custom module in the library and drag and drop it in the model at the right position.
In case of location error, switch the different blocks inside the model.

A new component like a new block of text, an image or a template, can be added to the mail body via
the right click menu. This action allows also to preview the component before adding it.

Remove a block/module from a  model

Two types of deletion are available:
A physical deletion: select the block and then right-click and select the option Remove text zone. The
block is completely removed from the model.

A logical deletion: select the block and click on the red cross to delete it. The block does not appear in
the model anymore, but is still in the personalized list of components; this list is accessible in the left
tab. The block is still available but deactivated. Just check its box in the list again and it reappears on
the document.
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The "forbidden" events

It is possible that some blocks of the model have been protected:
Their deletion is impossible (physical and logical): in this case, no deletion option is available.
Their modification is impossible: in this case the block appears in dimmed and cannot be selected.

5.4. Personalize text with variables

Email content can include variables (field) corresponding to the data of the recipient list.

This action allows to personalize each email for the recipient. The most commonly used data is the
recipient's title, last name and first name, but data such as the date of birth and place of residence (among
others) can also personalize content.

For inserting variable, double click in the text where adding them. Select the double angle brackets in the
toolbar "<>" and choose a variable in the list. The variable appears in blue between angle brackets.

If there is a variable missing, create it thanks to the Insert > Add a variable menu.
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The names of the variables must be strictly the same to those declared in the MailCsvHeader
parameter (refer to paragraph 3.3), or strictly identical to the names of the columns present in the first line
of the recipient list. If it is not the case, email processing will be unable to link the columns in the recipient
list to the variables inserted in the email and no automatic "mapping" is possible.

5.5. Personalize the images: the dynamic call

The calls to the images can be done dynamically by using all the data available in the contact list.

This action allows to personalize the images of each email, according to the profile or characteristics of the
future reader, but also according to the identity of the sender (logo of a company or a subsidiary for
example).

In this context, all or part of the image name must be available in the form of fields in the .csv file attached
to the emailing.

The dynamic call is configurable in the image properties:
Select an image
Right click then select Picture Properties
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On the name of the image, add the name of the field between rafters, (< >) which will make it possible to
call up the desired image. In the example above, <CONTACT_TITLE> will orient the call to the image of the
email banner, according to the recipient's title.

The image called via this composite name must be present and accessible via its URL on the dedicated
image server.

5.6. Manage the components of the emailing

This window lists the components of the emailing "document".
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To access to the Document tree window, select the "Document tree" icon  in the top header. This
window presents the list of blocks included in the email.

Thanks to the graphical indicators displayed at the right of the list items, the user can rapidly identify:
the model selected
the block added to the model selected: "+" icon
the personalized blocks: flag icon
the blocks not deletable: dimmed check box
the blocks logically deleted: unchecked components

 
Other action possible with Document tree window:

Delete physically a block (Right click / Remove textzone)
Reorganize blocks by moving them in the list with the mouse
Rename blocks, mainly when adding a new block to the model with a meaningful name, (Right click /
Properties)
Remove the current model to substitute it by another one : Right click on the line corresponding to the
model and remove it, than drag and drop a new model by selecting it in the repository tree (Repository
icon in the top header menu).
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5.7. Insert hyperlinks

Hyperlinks can be associated to each image (or image/button) or to a selected part of a text.

Two types of hyperlinks exist: 
Single link: its value is defined during design and is specific to the email context
Redefined linked: its value is chosen in a list of available links, which is unique for the Ksl project; this
link is potentially shared by several objects and emailings.

The style of the text to which associating the link is predefined, by default, in the configuration of the
emailing view (in Ksl Admin: menu Ksl Office setup > Office Profile).

"emailing_links.csv", the file of shared links

File in the URL encode format URL.
It centralizes generic or shared links, commonly shared by several emails or models, or even by all models:
e.g. the company's website, the unsubscribe link, the access to social networks..
The main advantage of this sharing process is the maintenance productivity when an URL changes, because
modifying the URL in the file impacts all the models and components using the URL.

This .csv file is integrated into the repository and physically present in the project directory, in
/components/ extern; it can be changed by editing it directly from this directory.

Its structure runs as follows: Name;Label;URL
Name: the link name provided in the list of available URLs when associating it to an image or text
Label: text used and displayed in the email
URL: the hyperlink address

For example: 
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Naelan_site_web;www.naelan.com;http://www.naelan.com
Naelan_contact;Help;http://www.naelan.com/contact/

Add an hyperlink to an text

Select a text and click on the icon  in the toolbar.
In the dialog box, select directly the local URL of the link associated to the text or select it in the list of
predefined links.

The Label is the text appearing in the email. If no text is selected, the label will be the Label of the
predefined link or it will be selected if local.

Add an hyperlink to an image

Select an image, right click and select Properties
The Label for the image is the alternative text used if the image cannot be downloaded; its selection is
recommended.
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Like the link for a text, select directly the local URL associated with the image or select it from the list
proposed if a predefined shared link is used.

Data-driven hyperlinks

It is possible to give a dynamic value to the URL of the hypertext link, whether local or shared (in the
centralized file), by positioning a variable between angle brackets on the part of the URL that needs to be
replaced by the contents of a variable.

For example: 
http://www.naelan.com/<COMP_NEWS>
If the value <COMP_NEWS> given in the recipient list is:
2017/07/04/news
Then the URL will be changed in:
http://www.naelan.com/2017/07/04/news
when previewing the emailing or sending it

Basic rules:
<COMP_NEWS> must correspond to a column of the recipient list
This column can be personalized to each recipient
Whatever its value, this text added to the URL, must correspond to an existing URL in order for the user to
use it

5.8. Create a new model from an emailing

In the menu, select File then Save as a model

Have you found the ideal structure for your newsletter? Have you defined the content of order
confirmations? You can save the current email as a new model in the repository.

Name the new model and select its storage branch in the classification tree (e.g. My Models). The branch
must belong to the root configured to be available in the emailing view so that the model be used when
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creating a new email.

The new model is stored as a "group" object and can be used for correction or update directly in the
library management, within the resource repository.

5.9. Modify launching parameters

Select the "Document parameter" button on the top banner, to access and modify the parameters of the
emailing campaign.

It is necessary to Refresh the document when the parameters are modified to take into account the
new parameter values.
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6. Preview the Email body

6.1. A data-driven HTML preview

The "Preview" action is available in the list of emailing actions.
It uses a specific service that builds the mail body in responsive html and replace the variable with the data
field of the first line of the recipient list (see "Create and set-up an emailing").

The result is an html preview of the mail body, whose variables are personalized by the data file and directly
opened in a new tab of the browser (below, variables are surrounded in green).

The valuation extracts the first contact from the file associated with the emailing campaign and integrates it
into the design of the email. This allows to test instantly the correspondence between the file columns and
the variables inserted in the email. It therefore allows, if necessary, an immediate correction of the contact
list or the email body.

Access to the images

The preview is also an opportunity to test the availability of images in the preset URL in the settings. It
validates their possible download from a customer's device. 
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6.2. Simulate the responsive behavior

To simulate and test the Responsive behavior, simply reduce the size of the browser window to see the
reorganization of the body of the email on a smaller reading media. Responsive behavior will instantly adapt
components to the new screen size.

6.3. Test hyperlinks

The HTML preview allows to test the hyperlinks associated to images or texts in the body of email.
The content of the link appears when positioning the mouse over an hyperlink. Click on the object to follow
the URL.
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7. Standard actions: test, send and archive

7.1. Actions and permissions

A set of actions is predefined for emailing but not all the groups are permitted by default to use them. Of
course the default permission described below can be completely change to cover other needs.

All the users can:
Access to the email information, mainly the campaign name (which can be modified) and a comment
Preview the responsive email body (cf. previous chapter)
Send for test

The ADMIN group (administrators) has additional permission: a user of this group can apply the whole
emailing campaign process, from the design of a campaign, its test, delivering and archiving. The possible
action buttons are presented below:

The USER group (emailing designers) cannot send a campaign without a validation. On the design step, the
users of this group can only send the emailing to validation.

The VALIDATOR group (validators) can access the emailing  "to be validated" in its Archive view and apply two
actions via its web interface: preview and send for test.  Indeed, its validation actions inform the USER that its
campaign can then effectively sent and archived. 

7.2. Testing an emailing campaign

Select the button "Document parameters" on the top menu at the left, and check the different parameters:
The recipient list for tests
The recipient list of the campaign
The object of the message
The sender

The action "Test the Emailing Campaign" allows to deliver the emailing to recipients if the testing list, under
the same conditions of the emailing campaign.
This test can be launched on different sets of files; simply select a new list of recipients in the parameters
and refresh the emailing to validate this change.

7.3. Send an emailing campaign to a recipient list
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 The checks described above, are of course always valid.

The email is then forwarded to the recipient list associated with the campaign in the parameters.

An emailing campaign can also be sent asynchronously from an external business application (via a
web service for example), but in this case, the campaign must be archived before.

7.4. Archive a campaign

The archiving of an emailing allows to archive a campaign. 
The campaign can of course be still accessed and copied, for example to create a new similar campaign.

7.5. Send a campaign to validation

If a validation is necessary and if a Ksl document validation workflow is already implemented, the emailing
can use workflow, before it is effectively sent and then archived.

 Campaign sending and workflow actions are never presented simultaneously because a user:
Either has permissions to deliver and archive campaign
Or has permissions to transmit his campaign to another user for validation; in this case, the two actions
of sending and archiving are not available only at the end of the process, when the campaign is
validated.
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8. Integrate emailing in a document process

8.1. Validation workflow 

Role identification

Two user groups: EMAIL_USER and EMAIL_VALIDATOR
The EMAIL_USER group is associated to emailing designer; these users will also send and archive
emailing after validation
The EMAIL_VALIDATOR group is associated to emailing validation; they can also modify the
communication.

Timeline of actions

1) The designer creates an emailing in the interactive application; he can preview the body of emails, test
the emailing with test recipient list, and send its campaign to a validator.

2) The validator accesses to the campaign in its "To be validated" archive view; he can modify the campaign,
preview it for test, reject or validate it after adding a comment. In the two validation action, the campaign
est is returned to the designer.

3a) If the campaign is rejected, the designer applies modifications and submit it a second time to validation
> return to step 2)
or 
3b) If the campaign is validated, the designer can send its emailing

4) The designer archives its campaign

5) The archived campaign is shared and can be view and use by another designers

Document types and properties

EMAIL_WORKFLOW : document type of an emailing campaign during its workflow process. The "status"
properties allows to follow the campaign in the workflow; the different status are the following:
TO_BE_VALIDATED, VALIDATED, REJECTED, ARCHIVES.

CAMPAGNE_EMAILING (Emailing campaign): document type of an emailing archived campaign; this type is
associated to the status "ARCHIVE" (archived).

Business process schema
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 The workflow provided can be fully adapted to the existing user profiles and to the internal processes.

8.2. Copy an emailing campaign

It can be useful and easier to select an archived campaign in order to create a new campaign and then get its
personalization.

The copy is an possible action on archived campaigns, and can be given to users according to permissions.

Click on the chosen campaign in the Archie view:

In the information details of the campaign, click on "COPY":

The selected campaign, the email body and all its parameters, will be copied and moved in the current
document view of Emailing tab. The name of this new campaign will be the name of the source campaign
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with the suffix "copy"

Click on the pencil to edit and customize the copy. The document's properties will allow to change the name

of this copy: menu Document > Properties or icon .

8.3. Delete an archived campaign

The deletion of a campaign is possible but subject to permissions; the administrator can be the only one
empowered to delete this document. The action button "DELETE" is then available on the campaign details
for this user profile.

Deletion is an action that can also be set up in the list of archived campaign for possible
multi-selection.

8.4. Send an emailing campaign from an external application

On the existing project, a validated emailing campaign can be sent directly from the KSL Office workflow. But
it is also possible to launch an archived email campaign from an external application (via web services for
example) with a new list of recipients as a parameter.

The AR_EmailingBatch service allows to launch an archived campaign with the following parameters:
P_DocumentName: name of the archived campaign
P_MailCsvFile: recipient filename with its path in .csv format (dynamic new recipient list). The structure
of this file must have the same format as the one defined for the campaign.
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